
PROTO-Series FAQs 
How can I demonstrate that the software has been properly installed and running correctly?  

All the Zachry software includes a VERIFY file that can be used to show that the program is 
running correctly. Simply open the VERIFY file and compare the results to the results shown in 
the User Documentation. The results should be identical. 
 
With PROTO-FLO, the user can run the PFloBenchmark.exe utility after running 
the VERIFY calculation. The utility will perform an electronic comparison to verify benchmark 
output and produce a Benchmark Report documenting any differences. 
 
Problems should be reported to ZACHRY NUCLEAR ENGINEERING in accordance with the 
procedure outlined in Product Support / Reporting Problems. 

 

What does the error message “Feature not found” mean?  

All the Zachry software is configured with the Sentinel HASP Licensing tools. When you receive 
this error message it is most likely an indication that you are not connected to your license 

server. 
 
You can check available licenses via the Sentinel Admin Control Center 
(http://localhost:1947). Under the Options menu, you can check which Features are available. 
 
Also, under the Options menu, you can update your Configuration. Under the "Access to 
Remote License manager, you can check to see if Allow Access to Remote License Managers is 
checked or input the name of your License Server in the Remote License Search 
Parameters text box. 

 

Can I export my PROTO-FLO output to Excel?  

Yes. There are several ways to do this, but the easiest way is to use User Defined Reports on the 
Outputs tab which allows the user to custom design reports for pipe data, node data, pump 
data, valve data, heat exchanger data, and trended data . When you click the button, you will be 



presented with configurable grids which can be exported to a variety of formats, including 
comma separated values (.csv) which can be opened using Excel. 
For even more customization, you can set parameters to be trended and choose that as a user 
defined report. 

 

 

Where can I find the User Documentation?  

A link to the pdf of the user documentation can be found under the File menu. 
 
If you want specific help, there are Help buttons strategically located throughout the software 
that will bring you to the help file. 

 

What do I do if I think there is a problem with the software?  

If you should have any questions on the operation of PROTO-FLO, first look in the 
documentation, or the Help file. If you cannot find the answer, contact us at (860) 446-9725, or 
at zne-support@zachrynuclear.com. When problems with the software are encountered during 
its use, the user should: 

Determine that the problem is not a hardware or installation problem by performing the 
Verification Exercise. 

Recreate the system configuration of concern. 

Select "Calculate" from the Calculation tab and provide any of the printable reports at 
convergence you feel appropriate. 

Contact us or complete a Software Corrective Action Request (SCAR) in accordance with the 
procedure outlined on the reverse side of the SCAR form supplied by Zachry and forward the 
SCAR and the above information to ZACHRY NUCLEAR ENGINEERING for evaluation. 

We at Zachry appreciate any comments or suggestions you may have regarding our software. 

 

 

 



I have installed the software (all V5 and above) but cannot get it to run. 

Install the 32-bit AccessDatabaseEngine available free from 
Microsoft https://www.microsoft.com/en-us/download/details.aspx?id=13255 

 

I have installed the software (all V5 and above) but get this error “The 
Microsoft.ACE.OLEDB.12.0 provider is not registered on the local machine” when I try to run.  

Install the 32-bit AccessDatabaseEngine available free from 
Microsoft https://www.microsoft.com/en-us/download/details.aspx?id=13255 

 

We have a new user. Do we need to install a new license file (trade .c2v and.v2c files)?  

If your license is on a license server, you do not need to trade files. 
 
Run the HASPUsersSetup.exe on the new computer and then the Proto-Flo (or Proto-HX) 
Workstation Setup. 
 
If you can see the features from the license 
server http://localhost:1947/_int_/features.html you are all set. 
 
If you do not see features, you need to add the server to the Search Parameters 
on http://localhost:1947/_int_/config_to.html 

 

I received an error during installation.  

Right Click on the Setup.exe file in the File Explorer and choose “Run as administrator”. 
If you still get an error, then check your firewall. 

 

I received the error “Unable to Find Vendor Library. Error Code: HASP_GET_INFO, 48”  

Important note: the error might have different text preceding error code 48. It might be 
"hasp_no_vlib", "hasp_update" or something else. The solution remains the same regardless of 
this text. 
 
One of the files that are essential for the licensing service functioning is absent. It is necessary to 
restart the computer and check whether the following file exists: 
 
Program Files\Common Files\Aladdin Shared\HASP\haspvlib_70678.dll 
 
One of the main causes of this error is oversensitive antivirus software. If there is such software 



on the problematic PC, it should be disabled while the following actions are performed. 
Additionally, the specified path (Program Files\Common Files\Aladdin 
Shared\HASP\haspvlib_70678.dll) should be added to the antivirus list of exceptions. 
 
First, try to reinstall the software with the antivirus software disabled. 
 
If this does not solve the problem, then: 
 
If the file does not exist, it is necessary to copy it from the distribution CD 
 
Then, it is necessary to stop the Sentinel LDK License Manager service from the Services list 
(Control Panel | Administrative Tools | Services), unzip the file to the location specified above, 
and start the service. 

 

I am receiving one of the following errors when I try to run my model: “Operation must use an 
updateable query.” “Access to path C:\Users\... …\ST.PHXST” is denied.” What can I do?  

There is a problem with the working database temporary file. Delete the temporary file in your 
Temp folder and reopen the last saved copy of your model. The temporary database file will 
likely be stored at a file path similar to this one: 
C:\Users\(user folder name)\AppData\Local\Temp\ST.PHXST. 
 
This folder may be hidden. If you cannot find it, search your C drive for the file ST.PHXST and 
open the folder location for the result to ensure that you are deleting the temporary file and not 
the one stored in your Program folder. You can also opt to display hidden folders from the 
“View” settings in your “Folder and search options” menu. 
 
The above file name applies to the PROTO-HX Shell and Tube module. For Air Coil, Plate Frame 
and PROTO-FLO, the temporary file names will be AC.PHXAC, PF.PHXPF, and FloIn.accdb 
respectively. 

 

Where can I find the appropriate inputs to build my heat exchanger model?  

Ideally, the design basis for your heat exchanger model should come from the vendor 
documentation for the equipment you are modeling, taking into consideration any changes that 
have been made to the equipment since its manufacture, which can be applied after 
benchmarking to the original design performance. Design performance data used to benchmark 
the model, like inlet and outlet temperatures and flows, design fouling, and overall heat transfer 
coefficient, are frequently documented on the vendor datasheet. Physical characteristics such as 
the dimensions and materials, number and pitch of tubes, and air coil serpentine type, are also 
frequently found on the vendor datasheet but can also be found on equipment drawings. 
 
Other potential sources of information include equipment procurement specifications, 



calculation reports (such as sizing calculations), walkdowns, maintenance records, and 
contacting the equipment vendor. Some inputs can be calculated or estimated from other 
available information using geometry or heat transfer equations. 

 

How does the overall fouling factor relate to the tube-side and shell-side fouling used to build 
my PROTO-HX model?  

PROTO-HX treats the entered values as if they are acting on the inside and outside 
surface of the tube. PROTO-HX combines the two fouling resistances into a single overall 
fouling resistance by using the following equation: 

 

 

Where: 
Rf = overall fouling thermal resistance (hr-ft2-°F/Btu) 
Rfi = inside surface fouling thermal resistance (hr-ft2-°F/Btu) 
Ao = effective heat transfer area on outside surface (in2) 
Ai = effective heat transfer area on inside surface (in2) 
Rfo = outside surface fouling thermal resistance (hr-ft2-°F/Btu) 

 
The tube-side fouling is increased by application of the outside-to-inside area ratio to 
place them at an equivalent area basis before combining them. It is important to 
recognize that some vendors report both fouling resistances with respect to the outside 
surface. How the vendor treated these fouling resistances is only known if both a clean 
and service (fouled) overall heat transfer coefficient (U) are provided. The user can 
calculate the overall fouling resistance used by the vendor by back-calculating it from 
the following equation:  

 
Where: 
Uservice = overall heat transfer coefficient for a heat exchanger in the “service” or 
“fouled” 
condition (i.e., overall fouling = design value) (Btu/hr-ft2-°F) 
Uclean = overall heat transfer coefficient for a heat exchanger in the clean condition 
(i.e., overall fouling = 0) (Btu/hr-ft2-°F) 

 



In my PROTO-HX Shell and Tube model, should I use the Petukhov-Kirilov or Sieder-Tate tube-
side correlation?  

The Petukhov-Kirillov correlation is used by default in the turbulent flow regime (Reynolds 
Number greater than 10,000) due to its reported accuracy. When Petukhov-Kirillov is selected, 
the Churchill correlation will be used when the tube side conditions are less than a Reynolds 
Number of 10,000. The Sieder-Tate correlation remains an option to allow analysis consistency 
with previous versions of the code and is used for all flow regimes if selected. The higher 
uncertainty inherent in the Sieder-Tate is only a factor in the uncertainty analysis that 
accompanies the analysis of thermal performance test data. Tube-side Prandtl Numbers must 
fall within the following limits: 

Petukhov-Kirillov correlation 0.5 < Pr < 200 

Sieder-Tate correlation for 0.7 < Pr < 16,700 

 

I don’t see a PROTO-HX Air Coil configuration that exactly matches the dimensions of my air coil. 
Which configuration should I use?  

The library of coils represents the population of coil configurations that have undergone 
extensive testing to derive the air-side film convection heat transfer coefficient relationship with 
Reynolds number. Since very few coils in service today truly reflect the exact geometries in the 
PROTO-HX Air Coil Module configuration library, the user is left to select a configuration from 
the library that best matches the subject coil (the coil that is being modeled). The user 
documentation contains a table of the parameters associated with each library configuration. 
The following guidelines are offered for this selection process: 

Identify the fin type: 

Circular Fins (CF) 

Square Fins (SQR) 

Identify the air-side Reynolds Number range of interest taking into account possible variations in 
air-side flow rate (e.g., fans that can operate in more than one speed), modes of operation (e.g., 
dry versus wet, normal versus post-accident), and temperature conditions. 

If multiple configurations still remain available to choose from, the user should evaluate the 
relative “compactness” of the library coil compared to the subject coil considering the following 
parameters (in the indicated order): 

Fin pitch (fins per inch) 

Tube transverse pitch (tube separation perpendicular to air flow direction) 

Tube outside diameter 

Tube longitudinal pitch (tube separation parallel to air flow direction) 



The precise selection of the library configuration is not critical as long as the aforementioned 
criteria are used. This process only selects the starting correlation for the air-side convection 
heat transfer film coefficient. The benchmarking process will derive the necessary correction to 
this correlation to match vendor-specified performance capability. 

 

Can I open my legacy model in the latest version of PROTO-HX? 

Version 5 PROTO-HX Shell and Tube models can be opened directly in Version 6. Version 4 
models can be imported to Version 6. After importing from Version 4, the user should check the 
configuration of the heat exchanger and compare output reports to verify the conversion. 
Legacy models should be rebuilt in PROTO-HX Air Coil Versions 5 and 5.10 and PROTO-HX Plate 
Frame Version 5. 


